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Chapter  1

Exploring the AutoCAD and 
AutoCAD LT Interface

Before you can start to use AutoCAD 2009’s new capabilities, you’ll need to become familiar 
with the basics. If you’re completely new to AutoCAD, you’ll want to read this first chapter care-
fully. It introduces you to many of AutoCAD’s basic operations, such as opening and closing 
files, getting a close-up look at part of a drawing, and changing a drawing. If you’re familiar 
with earlier versions of AutoCAD, you should review this chapter anyway to get acquainted 
with the features you haven’t already used.

Autodesk releases new versions of AutoCAD every year. Part of this strategy is to introduce 
improvements that focus on a particular category of features. This latest version, AutoCAD 2009, 
includes several new features focused on the user interface. AutoCAD now sports a new tool 
panel called the Ribbon, which includes the most common tools needed to produce technical 
drawings of all types. There is more information available on every tool, making this version of 
AutoCAD one of the easiest to learn. All you have to do is hover your cursor over a tool or menu 
option to find out what it’s for and how to use it.

You’ll get a chance to explore these new features as you work through this book. Before you 
begin the exercise later in this chapter, make sure that you have downloaded the sample files for 
this book. See the Introduction for details. 

Let’s get started with some basics. 
This chapter includes the following topics: 

Using the AutoCAD Window•u	

Opening an Existing File•u	

Getting a Closer Look with the Zoom Command•u	

Saving a File As You Work•u	

Making Changes and Opening Multiple Files•u	
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4  | Chapter  1  Exploring the AutoCAD and AutoCAD LT Interface

Taking a Guided Tour
In this section, you’ll get a chance to familiarize yourself with the AutoCAD screen and how 
you communicate with AutoCAD. As you do the exercises in this chapter, you’ll also get a feel 
for how to work with this book. Don’t worry about understanding or remembering everything 
you see in this chapter. You’ll get plenty of opportunities to probe the finer details of the pro-
gram as you work through the later chapters. To help you remember the material, you’ll find 
a brief set of questions at the end of each chapter. For now, just enjoy your first excursion into 
AutoCAD.

Note

In this chapter, and throughout the rest of the book, when I say AutoCAD, I mean both AutoCAD and 
AutoCAD LT. Some topics apply only to AutoCAD. In those situations, you’ll see an icon indicating that 
the topic applies only to AutoCAD and not to AutoCAD LT. If you’re using AutoCAD 2009 LT, these icons 
can help you focus on the topics that are more relevant to your work.

Note

AutoCAD 2009 is designed to run on Windows XP and Windows Vista. This book was written  
using AutoCAD 2009 running on Windows XP Professional.

If you already installed AutoCAD and are ready to jump in and take a look, proceed with the 
following steps to launch the program:

	 1.	 Choose Start  All Programs  Autodesk  AutoCAD 2009  AutoCAD 2009. You can 
also double-click the AutoCAD 2009 icon on your Windows Desktop. LT users will use 
AutoCAD LT 2009 in place of AutoCAD 2009.

	 2.	 The opening greeting, called a splash screen, tells you which version of AutoCAD you’re 
using, to whom the program is registered, and the AutoCAD dealer’s name and phone 
number, should you need help. If this is the first time you’ve started AutoCAD after in-
stalling it, you’ll also see a dialog box asking you to register the product.

	 3.	 You may also see the New Features Workshop screen, which offers a set of tutorials 
showing you the new features of AutoCAD 2009. Click the No, Don’t Show Me This 
Again or Maybe Later radio button, and click OK. You can always get to the New Fea-
tures Workshop screen from the AutoCAD Help menu in the Menu Browser. 

	 4.	 The AutoCAD window displays a blank default document named Drawing1.dwg, as 
shown in Figure 1.1. Although it doesn’t appear in Figure 1.1, to show more of the draw-
ing area, AutoCAD users may see the Sheet Set Manager palette to the left of the Auto-
CAD window. LT users may see the Info palette to the left of the AutoCAD window.
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Taking a Guided Tour |  5

If this is the first time you’ve started AutoCAD since you installed it, you’re asked to register 
and authorize AutoCAD in step 2. If you’re using the trial version, you can use the default serial 
number 000-00000000 for the one-month trial. After you’ve entered the registration information, 
you see the New Features Workshop window described in step 3.

Let’s look at the AutoCAD window in detail. Don’t worry if it seems like a lot of information. 
You don’t have to memorize it, but by looking at all the parts, you’ll be aware of what is available 
in a general way.

The AutoCAD Window
The AutoCAD program window is divided into six parts:

Menu Browser•u	

Quick Access toolbar•u	

Ribbon•u	

Drawing area•u	

Command window•u	

Status bar•u	

Figure 1.1, shown earlier in this chapter, shows a typical layout of the AutoCAD program 
window. Along the top is the Quick Access toolbar, and just below that is the Ribbon. At the bot-
tom are the Command window and the status bar. The drawing area occupies the rest of the screen. 
You can organize the AutoCAD window into any arrangement you want and save it as a work-
space. You can save and recall a workspace at any time using the Workspace Switching tool in 

Figure 1.1 
A typical arrange­
ment of the 
elements in the 
AutoCAD window. 
The Sheet Set 
Manager palette 
(or Info palette  
for LT) is closed for 
clarity.

Quick Access toolbar

Menu
Browser

Ribbon

Drawing
area

UCS
Command
window

Status bar

InfoCenter
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6  | Chapter  1  Exploring the AutoCAD and AutoCAD LT Interface

the status bar (you’ll learn more about this tool in the next chapter). The default workspace in 
Figure 1.1 is called the 2D Drafting & Annotation workspace, which is one of two workspaces 
that come built into AutoCAD.

Figure 1.2 shows AutoCAD’s 3D Modeling workspace, which has a different set of screen ele-
ments. Figure 1.2 also shows a standard AutoCAD drawing file with a few setting changes to 
give it a 3D appearance. Beneath these external changes, the underlying program is the same.

Note

You’ll learn more about workspaces later in this chapter and in Chapter 26.

The Quick Access toolbar at the top of the drawing area (as shown in Figure 1.3) includes 
the basic file handling functions that you find in nearly all Windows programs. The Ribbon 
provides nearly all the commands you’ll need using icon tools. In the upper-left corner, the red 
AutoCAD icon features the Menu Browser, which is like a navigation panel offering many of the 
same commands as the Ribbon panel.

The drawing area occupies most of the screen. Everything you draw appears in this area. As 
you move your mouse around, crosshairs appear to move within the drawing area. This is the 
drawing cursor that lets you point to locations in the drawing area.

Figure 1.2 
The 3D Modeling 
workspace offers 
an alternative  
arrangement of  
the elements in the 
AutoCAD window.
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Taking a Guided Tour |  7

The Command window, located just below the drawing area, gives you feedback about Auto-
CAD’s commands as you use them. You can move and resize this window just as you move and 
resize other display components. By default, the Command window is in its docked position, as 
shown in Figure 1.4.

Below the Command window is the status bar (see Figure 1.4). The status bar gives you infor-
mation at a glance about the state of the drawing. For example, the coordinate readout at the far 
left of the status bar tells you the location of your cursor. The tools in the status bar offer aids to 
the drafting process.

Picking Points in the Drawing Area

Now that you’ve seen the general layout of AutoCAD, take a look at the coordinate readout and 
the drawing cursor to get a sense of how the parts of the AutoCAD screen work together:

	 1.	 Move the cursor around in the drawing area. As you move it, notice how the coordinate 
readout changes to tell you the cursor’s location. It shows the coordinates in an X, Y, Z 
format.

	 2.	 Place the cursor in the middle of the drawing area, and click the left mouse button. Move 
the cursor and a rectangle follows. This is a window selection; you’ll learn more about this 
window in Chapter 2. You also see a coordinate readout following the cursor and a mes-
sage asking you to Specify opposite corner:. This display at the cursor is called the 
dynamic input. You’ll learn more about it a little later in this chapter.

Figure 1.3 
The Quick Access 
toolbar, featuring 
basic Windows 
file handling func­
tions, appears 
above the Ribbon, 
to the right of the 
Menu Browser.

Ribbon panel 
title bars

Quick Access toolbar InfoCenter

Ribbon tabs

Ribbon panels

Figure 1.4 
The Command 
window and the 
status bar

Coordinate readout

UCS icon

Command
window
Status bar

Command line
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8  | Chapter  1  Exploring the AutoCAD and AutoCAD LT Interface

Note

If you don’t see the Dynamic Input display, click the Dynamic Input tool in the status bar to turn  
it on. 

	 3.	 Move the cursor a bit in any direction; then, click the left mouse button again. Notice that 
the window selection disappears, as does the Dynamic Input display.

	 4.	 Try picking several more points in the drawing area. Notice that as you click the mouse, 
you alternately start and end a window selection.

If you happen to click the right mouse button, a shortcut menu appears. A right-click fre-
quently opens a menu containing options that are context sensitive. This means the contents of 
the shortcut menu depend on the location where you right-click as well as the command that 
is active at the time. If there are no appropriate options at the time of the right-click, AutoCAD 
treats the right-click as an ↵. You’ll learn more about these options as you progress through the 
book. For now, if you happen to open this menu by accident, press the Esc key to close it.

The UCS Icon

In the lower-left corner of the drawing area, you see an L-shaped arrow. This is the User Coordinate 
System (UCS) icon, which tells you your orientation in the drawing. This icon becomes helpful 
as you start to work with complex 2D drawings and 3D models. The X and Y arrows indicate the 
X and Y axes of your drawing. The little square at the base of the arrows tells you that you’re in 
what is called the World Coordinate System (WCS). Chapter 21 discusses this icon in detail. For 
now, you can use it as a reference to tell you the direction of the axes.

If You Can’t Find the UCS Icon

The UCS icon can be turned on and off, so if you’re on someone else’s system and you don’t see the 
icon, don’t panic. If you don’t see the icon or it doesn’t look as it does in this chapter, see Chapter 21 
for more information.

The Command Window

At the bottom of the screen, just above the status bar, is a small horizontal window called the 
Command window. Here, AutoCAD displays responses to your input. By default, it shows two 
lines of text. The bottom line shows the current messages and the top line shows messages that 
have scrolled by or, in some cases, components of the current message that don’t fit in a single 
line. Right now, the bottom line displays the message Command (see Figure 1.4, earlier in this 
chapter). This prompt tells you that AutoCAD is waiting for your instructions. When you click a 
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Taking a Guided Tour |  9

point in the drawing area, you see the message Specify opposite corner:. At the same time, 
the cursor starts to draw a window selection that disappears when you click another point. The 
same message appears in the Dynamic Input display at the cursor.

As a new user, pay special attention to messages displayed in the Command window and the 
Dynamic Input display because this is how AutoCAD communicates with you. Besides giving 
you messages, the Command window records your activity within AutoCAD. You can use the 
scroll bar to the right of the Command window to review previous messages. You can also en-
large the window for a better view. (Chapter 2 discusses these components in more detail.)

Now, let’s look at AutoCAD’s window components in detail.

Note

The Command window and the Dynamic Input display allow AutoCAD to provide text feedback on 
your actions. You can think of these features as a chat window to AutoCAD—as you enter commands, 
AutoCAD responds with messages. As you become more familiar with AutoCAD, you may find you 
don’t need to rely on the Command window and Dynamic Input display as much. For new and casual 
users, however, the Command window and Dynamic Input display can be helpful in understanding 
what steps to take as you work.

The Menu Browser
The Menu Browser is a bit like the Folders view in the Explore bar of Windows Explorer. It dis-
plays the different categories of commands in a vertical column. Click on a category and the list 
expands to show more options. Try it out to see how it works firsthand.

	 1.	 Click the Menu Browser icon and then point to the View option. The list of items that 
appears includes the commands and settings that let you control the way AutoCAD 
displays your drawings (see Figure 1.5). Don’t worry if you don’t understand them yet; 
you’ll get to know them in later chapters.

Note

LT users won’t see the Render option in the View menu.

	 2.	 Move the highlight cursor slowly down the list of view options in the right-hand column. 
As you highlight some of the options, notice that a tool tip appears just below. These tool 
tips help you choose the menu option you need. Other items that show an arrowhead to 
the left will expand to show more options when you click on them (see Figure 1.5).
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10  | Chapter  1  Exploring the AutoCAD and AutoCAD LT Interface

Note

If you look carefully at the command descriptions in the tool tip, about halfway down you’ll see an odd 
word with an icon to the left. This is the keyboard command equivalent to the highlighted option in 
the menu. You can type these keyboard commands to start the tool or menu item that you’re pointing 
to. You don’t have to memorize these command names, but knowing them will be helpful to you later 
if you want to customize AutoCAD.

	 3.	 Some of the menu items have triangular arrowheads to their left. This means the option 
has additional choices. For instance, click on the Zoom option and another set of options 
appears below it. This new set of options is called a cascading menu. Whenever you see a 
menu item with the triangular pointer, you know that this item opens a cascading menu 
offering a more detailed set of options.

	 4.	 Other menu options are followed by an ellipsis (…). This indicates that the option dis-
plays a dialog box. For instance, move the highlight cursor to the Named View option in 
the Menu Browser’s View option.  The View Manager dialog box appears.

	 5.	 Click Cancel to exit the dialog box.

In addition to offering most of the AutoCAD commands, the Menu Browser gives you a con-
venient way to find recently used commands and files. If you look at the bottom of the Menu 
Browser, you’ll see three items: Recent Documents, Open Documents, and Recent Actions, as 
shown in Figure 1.6. If you point to or click on an option, the panel to the right changes to show 
you a list pertaining to it. For example, if you point to Recent Documents, the panel to the right 
displays a list of files on which you have recently worked. 

Figure 1.5 
The View option in 
the Menu Browser 
showing a typical 
tool tip

Tool tip name
Description
Command name

Options with 
arrowheads
expand to show 
more options.

Options with icons
invoke commands 
and will show tool 
tips when you hover 
your cursor over them.

Tool tips give a 
brief description 
of the option as 
well as the proper 
command name 
for the option.
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Taking a Guided Tour |  11

You can use the View tool in the upper-right portion of the Menu Browser to select the way 
the list of files are displayed in a manner similar to the way you would use the Windows Explor-
er Views option. You can click on this icon and select Medium Images to have the list display the 
files with thumbnail images of their content. Hover over a file name and you will see a tool tip 
that displays a larger thumbnail of the drawing.

The Open Documents option lets you quickly change from one open file to another when you 
are viewing your files full screen. Finally, the Recent Actions option lists recent activity in the 
Menu Browser. You can repeat an action you’ve performed through the Menu Browser by select-
ing from this list. This is a handy tool if you are performing repetitive tasks, though you have to 
remember to start the task from the Menu Browser before they will become available under the 
Recent Actions option.

Communicating with the Command Window and Dynamic Input Display

AutoCAD is the perfect servant: It does everything you tell it to and no more. You communicate with AutoCAD 
by using tools and menu options. These devices invoke AutoCAD commands. A command is a single-
word instruction you give to AutoCAD telling it to do something, such as draw a line (the Line tool in the 
Draw Ribbon panel) or erase an object (the Erase tool in the Modify Ribbon panel). Whenever you invoke 
a command, by either typing it or selecting a menu or tool, AutoCAD responds by presenting messages 
to you in the Command window and the dynamic input display or by displaying a dialog box.

Figure 1.6 
Options at the  
bottom of the Menu 
Browser give you 
ready access to 
recent files and 
actions.

These options give you 
access to recent documents 
and actions.

Use the View tool to change 
the panel to show previews 
of the items in the list

Hover over an item 
in the list to get 
information about 
the item and a 
preview image.
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12  | Chapter  1  Exploring the AutoCAD and AutoCAD LT Interface

The messages in the Command window, or in the Dynamic input display, often tell you what to do next, 
or they may display a list of options. A single command often presents a series of messages, which you 
answer to complete the command. These messages serve as an aid to new users who need a little help. 
If you ever get lost while using a command or forget what you’re supposed to do, look at the Command 
window for clues. As you become more comfortable with AutoCAD, you’ll find that you won’t need to 
refer to these messages as frequently.

As an additional aid, you can right-click to display a context-sensitive shortcut menu. That is, if you’re 
in the middle of a command, this menu displays a list of options specifically related to that command. 
For example, if you right-click your mouse before picking the first point for the rectangle command, 
a menu opens, displaying the same options that are listed in the Command prompt plus some ad­
ditional options.

Finally, the Dynamic input display allows you to enter dimensional data of objects as you draw them. 
Besides echoing the command-line messages, the Dynamic input display shows temporary dimensions, 
coordinates, and angles of objects you’re drawing and editing. As you enter coordinate or angle values 
through the keyboard, they appear in the Dynamic Input display. You can easily turn the Dynamic In­
put display on or off by clicking on the Dynamic Input tool in the status bar. When the Dynamic Input 
display is turned off, your keyboard input appears in the Command window.

The Ribbon
The most prominent feature in the AutoCAD window, besides the drawing area, is the Ribbon 
(see Figure 1.7). This is where you’ll be selecting tools to draw, edit, or perform other functions. 
The Ribbon contains a set of panels representing groups of tools and features. The name of 
each Ribbon panel is found in its title bar at the bottom of the panel. Ribbon panels are further 
organized by the tabs that appear above them. All of the tools in the Ribbon offer tool tips that 
provide a short description to help you understand what each tool icon represents.

Figure 1.7 
A typical tool tip 
from a Ribbon 
panel tool.

Description/tutorial

Keyboard command equivalent

Context-sensitive help

Ribbon tabs

Ribbon panels

Ribbon panel 
title bars

Tool name
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Note

If you see only the Ribbon tabs, right-click on one of the tabs and choose Minimize  Show Full Ribbon. If 
you don’t even see the tabs, press the Esc key twice and type Ribbon ↵.

Move the arrow cursor onto one of the Ribbon panel tools and leave it there for a moment; 
you’ll see a tool tip appear just below the cursor. Hold the cursor there a bit longer and the tool 
tip changes to give you even more information about the tool. 

In most cases, you’ll be able to guess what each tool does by looking at its icon. The icon with 
an arc in the Draw Ribbon panel, for instance, indicates that the tool draws arcs; the one with 
the circle shows that the tool draws circles; and so on. For further clarification, the tool tip gives 
you the name of the tool.

As a new user, you’ll find these tool tips helpful because they show you the name of the tool 
and a brief description of how to use it. Typically, when I ask you to select a tool, I’ll use the 
name shown in the tool tip to help you identify the tool. In the case of a tool with flyouts, the 
tool name changes under different conditions. For those tools, I’ll describe the tool using a gen-
eral description. You’ll learn more about flyouts a bit later in this chapter. 

Note

As you work through this book, I will ask you to select tools from the Ribbon panels. You’ll often be 
asked to switch between different tabs to select tools from other sets of panels. To make the process 
simpler to read, I’ll use a somewhat abbreviated description of a tools location. For example, to use 
the Line tool, I’ll say, “Click the Line tool from the Home tab’s Draw panel.” To use the Move tool, I’ll 
say, “Click the Move tool in the Home tab’s Modify panel,” and so on.

Expanding Panels

In addition to the visible tools, a few tools are hidden from view. You can expand many of the 
Ribbon panels to select more tools. If you see an arrowhead to the right of a panel’s title bar, 
you can click the title bar to expand the panel (see Figure 1.8). The set of tools expands to reveal 
some additional tools. If you click in the drawing area, the expanded panel shrinks back to its 
original size. As an alternative,  you can click the pushpin icon in the expanded panel title bar to 
lock the panel in its open position.

Note

From now on, I’ll refer to the location of additional tools as the “expanded panel.” For example, I’ll say, 
“Click the Ray tool in the expanded Draw panel” when I want you to select the Ray tool.
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14  | Chapter  1  Exploring the AutoCAD and AutoCAD LT Interface

Understanding Flyouts

One more feature you’ll want to know about are the flyouts. Flyouts are similar to the expanded 
panels because you can click on an arrowhead to gain access to additional tools. Instead of a 
whole panel, however, flyouts give you access to different methods for using a particular tool. For 
example, AutoCAD lets you draw circles in several different ways so it offers a flyout for the Circle 
tool in the Home tab’s Draw panel. If you click the arrowhead next to the circle icon in the Draw 
panel, you’ll see additional tools for drawing circles (see Figure 1.9). 

If you select a tool option from a flyout, that option becomes the default tool for that icon. For 
example, if you hover your cursor over the circle icon in the Draw panel, you’ll see that the tool 
tip shows “Center, Radius” for the tool’s name. If you click the arrowhead next to the Center, 
Radius tool and select 2-Point, then 2-Point becomes the default tool and you’ll see “2-Point” for 
the name of the tool in the tool tip (see Figure 1.10).

Figure 1.8 
The arrowhead  
in the panel title 
bar tells you that 
additional tools  
are available.

Pushpin iconClick the title bar 
to expand the panel.

Figure 1.9 
Flyouts

Click the flyout arrowhead 
to display additional tools.
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Note

Since the tool tip names of tools with flyouts can change, describing them by name can be a bit prob­
lematic—the name may have changed based on the last tool you used from a flyout. For this reason, 
if a tool has a flyout, I’ll refer to it by a general name that is related to the set of tools in a flyout rather 
than by the tool tip name. For example, I’ll call the circle icon tool the Circle tool rather than the Cen­
ter, Radius tool. Likewise, I’ll refer to the magnifying glass icon in the Utilities panel as the Zoom tool 
instead of the Extents tool.

The Zoom tool

The Toolbars
Between the Ribbon and the Menu Browser, you’ll be able to find nearly every tool you’ll need. 
At times, however, you may want readily available on the screen a set of tools that is geared to-
ward a specific task. AutoCAD offers a number of toolbars that contain tools for specific types of 
drawing functions. For example, the View toolbar offers a set of tools that quickly give you a 3D 
view. The Inquiry toolbar contains tools that display information about your drawing.

Figure 1.10 
The tool with a fly­
out will change to 
the last tool used.

Select 2-Point from the flyout and 
the default Circle tool becomes 2-Point.

The Circle tool starts 
out as Center, Radius…
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16  | Chapter  1  Exploring the AutoCAD and AutoCAD LT Interface

As you work though this book, occasionally you’ll be asked to open other toolbars. To get 
familiar with the process, try opening and closing one now.

	 1.	 Right-click in a blank area of the Quick Access toolbar and select Toolbars  AutoCAD  
Dimension. The Dimension toolbar appears in the drawing area (see Figure 1.11).

	 2.	 You won’t need the Dimension toolbar right now, so go ahead and close it by clicking the 
X in the upper-right corner of the toolbar.

AutoCAD remembers your toolbar arrangement between sessions. When you exit and then 
reopen AutoCAD later, the AutoCAD window appears just as you left it.

Tools versus the Keyboard

Throughout this book, you’ll be told to select tools from the Ribbon panels to invoke commands. For 
new and experienced users alike, the Ribbon panels offer an easy-to-remember method for accessing 
commands. If you’re an experienced AutoCAD user, you can type commands directly from the key­
board. Most of the keyboard commands you know and love still work as they did before.

Another method for accessing commands is to use accelerator keys, which are special keystrokes that 
open and activate drop-down menu options. You may have noticed that the commands in the menu 
bar and the items in the drop-down menus all have an underlined character. By pressing the Alt key 
followed by the key corresponding to the underlined character, you activate that command or option 
without having to engage the mouse. For example, to choose File  Open, press Alt, then F, and then 
finally O (Alt+F+O).

Many tools and commands have keyboard shortcuts. Shortcuts are one-, two-, or three-letter abbrevia­
tions of a command name. As you become more proficient with AutoCAD, you may find these shortcuts 
helpful. As you work through this book, the shortcuts will be identified for your reference.

Finally, if you’re feeling adventurous, you can create your own accelerator keys and keyboard shortcuts 
for executing commands by adding them to the AutoCAD support files. Chapter 26 discusses how to 
customize menus, Ribbon panels, toolbars, and keyboard shortcuts.

Figure 1.11 
The Quick Access 
toolbar

The Dimension toolbar appears.

Right-click the Quick Access toolbar 
to open the context-sensitive menu 
and then select Toolbars � AutoCAD � Dimension.
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Working with AutoCAD
Now that you’ve been introduced to the AutoCAD window, you’re ready to try using a few  
AutoCAD commands. First you’ll open a sample file and make a few modifications to it. In  
the process, you’ll become familiar with some common methods of operation in AutoCAD.

Opening an Existing File
In this exercise, you’ll get a chance to see and use a typical Select File dialog box. 

Note

Before you start, make sure you have downloaded and installed the sample files for this book from the 
Sybex website. See the introduction for instructions on how to find and download the sample files.

To start, you’ll open an existing file:

	 1.	 Click the close icon in the upper-right corner of the drawing area. It looks like an X. 

Minimize
Restore Down

Close

A message appears, asking whether you want to save the changes you’ve made to the cur-
rent drawing. Click No.

	 2.	 Click the Open tool in the Quick Access toolbar to open the Select File dialog box. This is 
a typical Windows file dialog box, with an added twist:  In the large Preview box on the 
right, you can preview a drawing before you open it, thereby saving time while searching 
for files. To the left is a panel known as the Places list in which you can find frequently 
used locations on your computer or the Internet (see Figure 1.12).

Note

If you don’t see a Preview box in the Select File dialog box, click the word Views in the upper-right corner 
and select Preview from the list that appears.
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18  | Chapter  1  Exploring the AutoCAD and AutoCAD LT Interface

	 3.	 In the Select File dialog box, open the Look In drop-down list and locate the Chapter 01 
folder of the Mastering AutoCAD 2009 sample files. (You may need to explore the list to 
find it.)

	 4.	 Move the arrow cursor to the clip.dwg file and click it. Notice that the clip.dwg filename 
now appears in the File Name input box above the file list. The Preview box also now 
shows a thumbnail image of the file. Be aware that files from older versions of AutoCAD 
may not show a thumbnail.

	 5.	 Click the Open button at the bottom of the Select File dialog box. AutoCAD opens the 
clip.dwg file, as shown in Figure 1.13.

The clip.dwg file opens to display a layout view of the drawing. A layout is a type of view 
in which you lay out different views of your drawing in preparation for printing. You can tell 
you are in a layout view by the white area over the gray background. This white area represents 
your drawing on a printed page. This view is like a print preview.

Figure 1.12 
The Select File 
dialog box

Figure 1.13 
The Layout1 view 
of the clip.dwg file
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Also note that the AutoCAD window’s title bar displays the name of the drawing. This offers 
easy identification of the file.

This particular file contains both 2D drawings and a 3D model of a typical locking clip. The 
Layoutview shows a top, front, and right-side view as well as an isometric view. 

Getting a Closer Look
One of the most frequently used commands is Zoom, which gives you a closer look at part of 
your drawing. This command offers a variety of ways to control your view. In this section, you’ll 
enlarge a portion of the clip drawing to get a more detailed look. To tell AutoCAD which area 
you want to enlarge, you use what is called a zoom window.

You’ll start by switching to a Model Space view of the drawing. The Model Space view places 
you in a workspace where you do most of your drawing creation and editing. Follow these steps:

	 1.	 Click the Model tool on the status bar at the bottom of the AutoCAD window.

 

Your view changes to show the full 3D model with the 2D representations of the model 
(see Figure 1.14).

	 2.	 From the Menu Browser, choose View  3D Views  Plan View  World UCS. You can 
also type PLAN↵W↵. Your display changes to a two-dimensional view looking down on 
the drawing, as shown in Figure 1.15.

Figure 1.14 
3D model with 2D 
representations of 
the model
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	 3.	 Click the Zoom tool in the status bar.

You can also click the Window tool from the Zoom flyout in the Home tab’s Utilities 
panel or type the command Z↵.

Click the flyout arrowhead.

Select Window.

Figure 1.15 
Placing the zoom 
window around 
the clip

And then
click here.

First click here…
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	 3.	 The Command window and the dynamic input display show the Specify corner of 
window…: prompt with some options. Look at the top image in Figure 1.15. Move the 
crosshair cursor to a location similar to the one shown in the figure; then, left-click the 
mouse. Move the cursor and the rectangle appears with one corner fixed on the point you 
just picked; the other corner follows the cursor.

	 4.	 The Command window and Dynamic Input display now show the Specify first corner: 
and Specify opposite corner: prompts. Position the other corner of the zoom window 
so it encloses the lower image of the clip, as shown in Figure 1.15, and left-click the mouse 
again. The clip enlarges to fill the screen.

In this exercise, you used the Window option of the Zoom command to define an area to 
enlarge for your close-up view. You saw how AutoCAD prompts you to indicate first one corner 
of the window selection and then the other. These messages are helpful for first-time users of 
AutoCAD. You’ll use the Window option frequently—not just to define views, but also to select 
objects for editing.

Getting a close-up view of your drawing is crucial to working accurately, but you’ll often 
want to return to a previous view to get the overall picture. To do so, choose Previous from the 
Zoom flyout in the Home tab’s Utilities panel. 

Do this now and the previous view—the one showing the entire clip—returns to the screen.
You can quickly enlarge or reduce your view by using the Zoom Realtime option of the Zoom 

command. Follow these steps to change your view with Zoom Realtime:

	 1.	 Click the Zoom tool on the status bar; then right-click and select Enter.

You can also right-click and choose Zoom from the shortcut menu. The cursor changes to 
a magnifying glass.

	 2.	 Place the Zoom Realtime cursor slightly above the center of the drawing area, and then 
click and drag downward. Your view zooms out to show more of the drawing.

	 3.	 While still holding the left mouse button, move the cursor upward. Your view zooms in 
to enlarge your view. When you have a view similar to the one shown in Figure 1.16, re-
lease the mouse button. (Don’t worry if you don’t get exactly the same view as the figure. 
This is just for practice.)

	 4.	 You’re still in Zoom Realtime mode. Click and drag the mouse again to see how you can 
further adjust your view. To exit, you can select another command besides a Zoom or Pan, 
press the Esc key, or right-click your mouse and choose Exit from the shortcut menu.
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	 5.	 Right-click now and choose Exit from the shortcut menu to exit the Zoom Realtime 
command.

Note

If you prefer, you can use the wheel on your mouse to zoom and pan over your view. Roll the wheel to 
zoom in and out or click and drag the wheel to pan.

As you can see from this exercise, you have a wide range of options for viewing your draw-
ings, just by using a few tools. These tools are all you need to control the display of 2D drawings.

Saving a File as You Work
It’s a good idea to save your file periodically as you work on it. As with any Windows program, 
you can save it under its original name (click the Save tool on the Quick Access toolbar) or under 
a different name (choose File  Save As from the Menu Browser), thereby creating a new file.

By default, AutoCAD automatically saves your work at 10-minute intervals under a name that 
is a combination of the current filename plus a number and that ends with the .sv$ filename 
extension; this is known as the Automatic Save feature. Using settings in the Options dialog box 
or system variables, you can change the name of the autosaved file and control the time between 
autosaves. See  “The Open and Save Tab” in Appendix A for details. 

Figure 1.16 
The final view  
you want to 
achieve in step 3  
of the exercise
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Note

By default, in Windows XP, the Automatic Save file is stored in C:\Documents and Settings\User 
Name\Local Settings\Temp\. You can find the exact location for your system by typing Savefile-
path↵ at the Command prompt. This file location is often set as a hidden folder, so you may need to 
set up Windows Explorer to display hidden folders before you can get to the Automatic Save file. See 
Appendix A for information on how to do this.

Making Changes
You’ll frequently make changes to your drawings. One of AutoCAD’s primary advantages is the 
ease with which you can make changes. The following exercise shows you a typical sequence of 
operations involved in changing a drawing:

	 1.	 Use the File  Save As Menu Browser option to save the current Clip.dwg file under the 
name MyFirst. For convenience, you can save your files in the My Documents folder.

	 2.	 From the Home tab’s Modify panel, click the Erase tool (the one with a pencil eraser 
touching paper). This activates the Erase command. 

Notice that the cursor has turned into a small square. This square is called the pickbox. 
You also see Select objects: in the Command window and the Dynamic Input display. 
This message helps remind new users what to do.

	 3.	 Move the pickbox over the drawing, placing it on various parts of the clip. Don’t click 
anything yet. Notice that as you hover your cursor over objects with the pickbox, they’re 
highlighted. This helps you see the objects that the pickbox is likely to select should you 
click the left mouse button.

	 4.	 Place the pickbox on the crosshatch pattern of the clip (see Figure 1.17), and click. The 
crosshatch changes in appearance from a dark highlight to a light highlight. The pick-
box and the Select objects: prompt remain, indicating that you can continue to select 
objects.

	 5.	 Press ↵. The crosshatch disappears. You’ve just erased a part of the drawing.

In this exercise, you first issued the Erase command and then you selected an object by using 
a pickbox to click it. The pickbox tells you that you must select items on the screen, and it shows 
you what you’re about to select by highlighting objects as you hover the cursor over them. Once 
you’ve clicked an object or a set of objects, press ↵ to move on to the next step. This sequence of 
steps is common to many of the commands you’ll work with in AutoCAD (see Figure 1.17).

Note

You can also click an object or a set of objects and then press the Delete key without using the  
Erase tool.
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Working with Multiple Files
You can have multiple documents open at the same time in AutoCAD. This can be especially 
helpful if you want to exchange parts of drawings between files or if you want another file open 
for reference. Try the following exercise to see how multiple documents work in AutoCAD:

	 1.	 Click the New tool on the Quick Access toolbar to open the Select Template dialog box.

Note

If you see the Create New Drawing dialog box after step 1, click the Start from Scratch button and 
select Imperial; then click OK and AutoCAD will display a default document. You’ll learn more about 
the Create New Drawing dialog box in Chapter 3. 

	 2.	 Make sure acad.dwt is selected, and then click Open.

	 3.	 Click the Menu Browser and choose Window  Tile Vertically to get a view of both draw-
ing files. This option in the Menu Browser acts just like its counterpart in other Windows 
programs allowing for multiple-document editing.

Note

When you create a new file in AutoCAD, you’re actually opening a copy of a template file, as you saw 
in step 1. A template file is a blank file that is set up for specific drawing types. The acad.dwt file is a 
generic template set up for Imperial measurements. Another template file called acadiso.dwt is  
a generic template useful for metric measurements. Other templates are set up for specific drawing-
sheet sizes and measurement systems. You’ll learn more about templates in Chapter 6.

Figure 1.17 
Erasing a portion 
of the clip

Click here.
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Next, let’s try drawing a rectangle to see how AutoCAD behaves while drawing objects:

	 1.	 Click the Rectangle tool in the Home tab’s Draw panel. 

Notice that the Command window and the message at the cursor now shows the follow-
ing prompt:

Specify first corner point or 

AutoCAD is asking you to select the first corner for the rectangle and, in brackets, it’s offering 
a few options that you can take advantage of at this point in the command. Don’t worry 
about those options right now. You’ll have an opportunity to learn about command options 
in Chapter 2. You also see the same prompt, minus the bracketed options, in the Dynamic 
Input display at the cursor.

	 2.	 Click a point roughly in the lower-left corner of the drawing area, as shown in Figure 1.18. 
Now, as you move your mouse, a rectangle follows the cursor, with one corner fixed at the 
position you just selected. You also see the following prompt in the Command window, 
with a similar prompt in the Dynamic Input display:

Specify other corner point or [Area/Dimensions/Rotation]:

	 3.	 Click another point anywhere in the upper-right region of the drawing area. A rectangle 
appears (see Figure 1.19) . You’ll learn more about the different cursor shapes and what 
they mean in Chapter 2.

Figure 1.18 
Selecting the first 
point of a rectangle

Click here to start the rectangle.
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	 4.	 Let’s try copying objects between these two files. Click in the window with the clip draw-
ing to make it active.

	 5.	 Click All from the Zoom flyout in the Home tab’s Utilities panel to get an overall view  
of the drawing. You can also click the Zoom tool in the status bar and type A↵ (see  
Figure 1.20).

	 6.	 Click the 2D version of the clip at the bottom of the drawing to select it. A series of 
squares and arrows appears on the drawing. These are called grips, and you’ll learn  
more about them in the next chapter (see Figure 1.21).

	 7.	 Right-click and select Copy.

	 8.	 Click inside the other drawing window to make it active.

	 9.	 Right-click and select Paste. The clip appears at the cursor in the new drawing.

	 10.	 Position the clip in the middle of the rectangle you drew earlier and left-click the mouse. 
The clip is copied into the second drawing.

	 11.	 This ends the exercises for this chapter. Save the file and then exit AutoCAD.

Figure 1.19 
After you’ve  
selected the first 
point of the rect­
angle, you see a 
rectangle follow 
the motion of  
your mouse.

Figure 1.20 
The Zoom flyout 
gives you an over­
all view of your 
drawing.
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Now you’ve had two files open at once. You can have as many files open as you want as long 
as your computer has adequate memory to accommodate them. You can control the individual 
document windows as you would any window, using the Window drop-down menu or the win-
dow control buttons in the upper-right corner of the document window.

Adding a Predrawn Symbol with the Tool Palette
In the preceding exercise, you saw how you can easily copy an object from one file to another by 
using the standard Windows Cut and Paste tools. AutoCAD offers a Tool Palettes tool that lets 
you click and drag predrawn objects into your drawing.

You can open the Tool palettes by clicking the Tool Palettes tool in the View tab’s Palettes 
panel. 

View tab

Tool Palettes tool in 
Palettes panel

Once it’s open, you can select a tab in the Tool Palettes window containing the predrawn ob-
jects you want to use and then click the specific object you want to add. The object appears at the 
cursor, ready for you to select a location (see Figure 1.22).

Figure 1.21 
Grips shown in the 
2D drawing.

Select this part 
of the drawing.
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In addition to predrawn objects, the Tool palettes offer a way to add fill patterns and other 
components quickly to your drawing. They’re great tools to help you manage your library of 
custom, predrawn symbols. Chapter 25 shows you how to use and customize the Tool palettes.

The Bottom Line

Using the AutoCAD Window  AutoCAD is a typical Windows graphics program that 
makes use of menus, toolbars, Ribbon panels, and palettes. If you’ve used other graphics pro-
grams, you’ll see at least a few familiar tools.

Master It  Name the components of the AutoCAD window you can use to select a func-
tion.

Getting a Closer Look with the Zoom Command  One of the first things you’ll want to 
learn is how to manipulate your views. The Zoom command is a common tool in graphics 
programs.

Master It  Name at least two ways of zooming into a view.

Saving a File As You Work  Nothing is more frustrating than having a power failure cause 
you to lose hours of work. It’s a good idea to save your work frequently. AutoCAD offers an 
autosave feature that can be a lifesaver if you happen to forget to save your files.

Master It  How often does the AutoCAD autosave feature save your drawing?

Making Changes and Opening Multiple Files  As with other Windows programs, you can 
have multiple files open and exchange data between them.

Master It  With two drawings open, how can you copy parts of one drawing into the 
other?

Figure 1.22 
The Tool palettes 
offer predrawn 
symbols that you 
can easily place in 
your drawings.

The symbol appears 
at the cursor ready 
to be placed in 
the drawing.

Select a tab containing 
predrawn symbols 
you want to use.

Click on a symbol.
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